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Pengantar NI Circuit Design Rangkaian 

Beberapa fitur yang dijelaskan mungkin tidak tersedia dalam edisi Anda Circuit Design Suite. Mengacu pada NI Circuit Design Suite Catatan Rilis untuk daftar fitur yang tersedia dalam edisi Anda. 

NI Circuit Design Suite Product Line 

National Instruments Circuit Design Suite adalah suite EDA (Electronics Desain Automation) alat yang membantu Anda dalam melaksanakan langkah-langkah utama dalam aliran desain rangkaian. 

Multisim adalah alat bantu yang dapat membuat skema dan simulasi program yang dirancang untuk skematis masuk, simulasi, dan untuk langkah Downstage, seperti  desain PCB. Yang dapat mensimulasikan baik analog / digital, dan juga simulasi mikrokontroler. 

Ultiboard digunakan untuk merancang PCB dengan menyediakan otomatis penempatan dan tata letak. 

Tutorial 

Buku ini berisi tutorial langkah-demi-langkah berikut: 
· Multisim Tutorial -Introduces Anda untuk Multisim dan yang banyak fungsi. 
· Ultiboard Tutorial -Shows Anda bagaimana untuk menempatkan komponen dan trace untuk rangkaian dijelaskan dalam bab Multisim Tutorial. Kamu juga akan belajar bagaimana autoplace bagian dan kemudian Autoroute mereka. 
· Multisim MCU Tutorial -Leads Anda melalui proses simulasi dan debugging rangkaian yang berisi mikrokontroler. Untuk informasi lebih rinci tentang fitur yang dibahas dalam bab-bab ini, lihat Bantuan Multisim atau Bantuan Ultiboard. 
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Multisim Tutorial

Bab ini berisi tutorial yang memperkenalkan Anda ke Multisim dan fungsi-fungsinya.


Pengantar Multisim Antarmuka 

Multisim adalah alat bantu skema rangkaian dan simulasi penerapan National Instrumen Circuit Design Suite, sebuah suite EDA (Electronics Desain Otomatisasi) alat-alat yang membantu Anda dalam melaksanakan langkah-langkah utama dalam aliran desain rangkaian. Multisim dirancang untuk masuk skema, simulasi, dan mengekspor ke langkah Downstage, seperti tata letak PCB


Antarmuka pengguna Multisim terdiri dari unsur-unsur dasar sebagai berikut: 
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Menu Bar, di mana Anda menemukan perintah untuk semua fungsi. 

Design Toolbox, di mana Anda dapat menavigasi melalui berbagai jenis file dalam proyek (skema, PCB, laporan), melihat hirarki skema ini dan menampilkan atau menyembunyikan lapisan yang berbeda. 

Component Toolbal, berisi tombol yang Anda gunakan untuk memilih komponen dari database Multisim untuk penempatan dalam skema Anda. 

Standar Toolbar berisi tombol untuk fungsi umum-dilakukan seperti bintang, Print, Cut, dan Paste

View Toolbar berisi tombol untuk memodifikasi cara layar ditampilkan. 

Simulation Toolbar berisi tombol untuk Start, Stop, dan  fungsi simulasi lainnya. 

Main Toolbar berisi tombol untuk fungsi Multisim umum. 

In Use List  daftar semua komponen yang digunakan dalam desain. 

Instrumen Toolbar berisi tombol untuk setiap instrumen. 

Circuit Window (atau ruang kerja) adalah di mana Anda membangun rangkaian yang akan Anda  desain. 

Spreadsheet View memungkinkan tampilan canggih cepat dan pengeditan parameter termasuk rincian komponen seperti trace kaki, RefDes, atribut dan kendala desain. Anda dapat mengubah parameter untuk beberapa atau semua komponen dalam satu langkah dan melakukan sejumlah fungsi lainnya. 


Overview 

Tutorial ini menuntun Anda dalam mendesain rangkaian, memahami skema rangkaian, melalui simulasi dan analisis. Setelah mengikuti langkah-langkah pada halaman berikut, Anda akan telah merancang sebuah rangkaian sinyal analog kecil, menguatkan dan kemudian menghitung keluaran dari sinyal pada counter digital sederhana. 

Tips-tips ditandai dengan kehadiran ikon di kolom sebelah kiri, sebagai di ujung bawah. 

[image: ] Tip Anda dapat mengakses bantuan online setiap saat dengan menekan <F1> pada keyboard, atau dengan mengklik tombol Bantuan dalam kotak dialog


Schematic Capture 


Pada bagian ini, Anda akan menempatkan dan kawat komponen di rangkaian ditampilkan di bawah
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Membuka dan Menyimpan File 

Menyelesaikan langkah berikut untuk memulai Multisim: 
Pilih Mulai> Semua Program »National Instruments» Circuit Design Suite 11.0 »Multisim 11,0. Sebuah file kosong terbuka pada ruang kerja yang disebut Design1.
 
Lakukan langkah-langkah berikut untuk menyimpan file dengan nama baru: 
1. Pilih File »Save As untuk menampilkan Windows standar dialog Save. 
2. Arahkan ke lokasi di mana Anda ingin file untuk tinggal, masukkan My Getting  Started sebagai nama file, dan klik tombol Save
[image: ] Tip Untuk menjaga terhadap kerugian kehilangan data, kita dapat membuat waktu auto-backup  file yang akan di Simpan pada  kotak dialog Preferences global. 
Menyelesaikan langkah berikut untuk membuka file yang sudah ada: 
Pilih File » Open, arahkan ke lokasi di mana file berada, sorot file, dan klik tombol Open. 

[image: ] Tip Untuk melihat file dari versi sebelumnya Multisim, pilih versi yang diinginkan di File Tipe drop-down di dialog Open. 

Menempatkan Komponen 

Lakukan langkah-langkah berikut untuk mulai menempatkan komponen: 
1. Buka MyGettingStarted.ms11 seperti dijelaskan di atas. 
2. Pilih Tempat »Komponen untuk menampilkan Pilih dialog Component box, arahkan ke 7-segmen display LED seperti gambar di bawah dan klik OK. Komponen ini muncul sebagai "hantu" pada kursor. 
[image: ]Tip Setelah Anda memilih Grup diinginkan dan Keluarga, mulai mengetik komponen  nama di lapangan Komponen browser. Saat Anda mengetik, string muncul di pencarian yang  lapangan di bagian bawah browser. Pada contoh di bawah, jenis seven_seg_decimal_com_a_blue. 
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3. Pindahkan kursor ke kanan bawah ruang kerja dan klik kiri untuk menempatkan komponen. Perhatikan bahwa Designator Referensi untuk ini komponen "U1".
4. Tempatkan komponen yang tersisa di daerah Digital Kontra seperti yang ditunjukkan di bawah
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[image: ] Catatan 
Ketika menempatkan resistor, induktor, atau kapasitor (komponen RLC), yang Pilih Kotak dialog komponen memiliki bidang yang sedikit berbeda dibandingkan komponen lainnya. Kapan menempatkan komponen ini, Anda dapat memilih kombinasi dari: nilai komponen (untuk Misalnya, nilai resistansi); ketik (misalnya, film karbon); toleransi; tapak dan pabrikan. Jika Anda menempatkan komponen yang akan akhirnya diekspor ke PCB tata letak, dan menjadi bagian dari Bill of Material, Anda harus berhati-hati bahwa kombinasi dari nilai-nilai yang Anda pilih di Pilih kotak dialog Komponen yang tersedia dalam dunia nyata, komponen purchaseable. 

[image: ] Tip Ketika menempatkan komponen RLC, ketik nilai perangkat yang Anda inginkan untuk menempatkan di bidang di bagian atas daftar Komponen. nilai tidak perlu muncul dalam daftar untuk ditempatkan pada skema. 
[image: ] Tip Sementara menempatkan 200 Ω resistor, putar untuk orientasi vertikal dengan menekan <Ctrl-R> pada keyboard Anda. 
[image: ] Tip Designators referensi (misalnya, U1, U2) ditugaskan dalam urutan yang komponen ditempatkan. Jika Anda menempatkan komponen dalam urutan yang berbeda dari aslinya rangkaian, penomoran akan berbeda. Ini tidak akan mempengaruhi operasi dari rangkaian dengan cara apapun.

5. Tempatkan komponen di bagian Kontra Control. Setelah penempatan, klik kanan pada masing-masing switch SPDT dan pilih Horizontal Flip
[image: ]
[image: ]  Tip Switch SPDT berada dalam kelompok Basic, Ganti keluarga. 
[image: ]  Tip Ketika sebuah komponen pada ruang kerja dan Anda ingin menempatkan komponen yang sama lagi, sorot dan pilih Edit »Copy, lalu Edit» Paste. Anda juga dapat memilih dari Di Gunakan Daftar dan klik untuk menempatkannya di ruang kerja. 

6. Tempatkan komponen di bagian Analog Amplifier seperti yang ditunjukkan di bawah ini, 
berputar sesuai kebutuhan. 
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7. Klik dua kali pada sumber sinyal tegangan AC dan mengubah tegangan yang (Pk) ke 0,2 V dan klik OK untuk menutup dialog

8. Tempatkan komponen di bagian Bypass Kapasitor seperti yang ditunjukkan di bawah. 
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9. Letakkan header dan komponen terkait seperti yang ditunjukkan di bawah ini
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[image: ]  Tip J3 adalah pada kelompok Basic, keluarga Konektor. 
[image: ]  Tip Setelah Anda memiliki kabel rangkaian, Anda bisa drop komponen dua-Pinned seperti resistor langsung ke kawat. Sambungan secara otomatis dibuat oleh Multisim. 

Wiring Circuit 
Semua komponen memiliki pin yang Anda gunakan untuk penjaluran kawat ke komponen lain 
atau instrumen. Begitu kursor Anda lebih dari pin, perubahan pointer ke crosshair, yang menunjukkan Anda dapat mulai kabel. 
[image: ]Tip Anda dapat kawat rangkaian yang Anda ditempatkan pada ruang kerja atau Anda dapat menggunakan Memulai 1.ms11 dari Mulai folder (ditemukan di dalam sampel map)


Lakukan langkah-langkah berikut untuk kawat rangkaian: 
1. Klik pada pin pada komponen untuk memulai koneksi (Anda pointer berubah menjadi crosshair) dan menggerakkan mouse. Sebuah kawat muncul, melekat untuk kursor Anda. 
2. Klik pada pin pada komponen kedua untuk menyelesaikan koneksi. Multisim secara otomatis menempatkan kawat, yang langsung terkunci ke konfigurasi yang tepat, seperti yang ditunjukkan di bawah ini. Fitur ini menghemat banyak waktu ketika kabel rangkaian besar.

[image: ]
[image: ] Tip Anda juga dapat mengontrol aliran kawat dengan mengklik poin yang Anda menggerakkan mouse. Setiap klik "perbaikan" kawat ke titik itu. 

3. Selesai kabel bagian Digital Kontra seperti yang ditunjukkan di bawah ini
[image: ]
[image: ]  Tip Gunakan Bus Vector Connect untuk kawat perangkat multi-disematkan seperti U3 dan R4 bersama dalam bis. Lihat Bantuan Multisim untuk rincian. 
[image: ] Tip Virtual Wiring -Untuk menghindari kekacauan, Anda dapat menggunakan koneksivirtual antara Kontra Control dan Digital kontra bagian menggunakan on-halaman konektor

4. Selesai kabel rangkaian seperti yang ditunjukkan di bawah ini
[image: ]

Simulation 

Simulasi rangkaian Anda dengan Multisim menangkap kesalahan awal dalam desain  mengalir, menghemat waktu dan uang. 

virtual Instrumentasi 

Pada bagian ini, Anda akan mensimulasikan rangkaian dan melihat hasil dengan osiloskop virtual. 
[image: ]  Tip Anda juga dapat menggunakan Memulai 2.ms11 dari Mulai map (ditemukan di dalam sampel map). 

1. J1, J2 dan R2 adalah komponen interaktif. 
Mengatur tombol interaktif untuk J1, J2 dan R2 dengan mengklik dua kali pada setiap  dan memilih tab Nilai. Di bidang Key, masukkan "E" untuk J1, "L" untuk  J2, dan "A" untuk R2. 

2. Tekan <E> pada keyboard untuk mengaktifkan counter, atau klik pada lengan saklar melebar yang muncul ketika Anda membawa kursor di atas J1. Aktifkan Aktif Rendah.
 
3. Pilih Simulasikan »Instrumen» Oscilloscope untuk menempatkan osiloskop di ruang kerja. Kawat instrumen seperti yang ditunjukkan pada langkah 5. 
[image: ] Tip Untuk mudah membedakan antara trace pada osiloskop, klik kanan pada kawat  terhubung ke "B" masukan lingkup dan pilih Segmen Color dari menu konteks yang  menampilkan. Pilih warna yang berbeda dari kawat yang terhubung ke "A" input,misalnya biru. (Mengubah warna kawat atau melakukan fungsi editing lainnya tidak dapat dilakukan saat  simulasi berjalan.) 

4. Klik dua kali pada icon lingkup untuk menunjukkan instrumen wajah. Memilih Mensimulasikan »Run. Output dari opamp muncul di lingkup. 
5. Sesuaikan Timebase untuk 2 ms / Div dan Skala Saluran A untuk 500 mV / Div. Anda akan melihat berikut ditampilkan pada ruang lingkup.

[image: ]
Sebagai rangkaian mensimulasikan, layar 7-segmen penting dan LED berkedip pada akhir setiap hitungan siklus. 

6. Tekan <E> pada keyboard sambil simulasi berjalan untuk mengaktifkan atau menonaktifkan meja. Aktifkan Aktif Rendah. Tekan <L> untuk memuat nol ke meja. Beban Active Low

Tekan <Shift-A> untuk mengamati efek penurunan potensiometer ini pengaturan. Ulangi, menekan <A> meningkat. 

[image: ] Tip Alih-alih menekan tombol yang disebutkan di atas, Anda bisa langsung memanipulasi komponen interaktif pada skema dengan mouse Anda. 

Analisa 

Pada bagian ini, Anda akan menggunakan Analisis AC untuk memverifikasi respon frekuensi  penguat. Lakukan langkah-langkah berikut untuk melakukan Analisis AC pada output op-amp: 

1. Klik dua kali pada kawat yang melekat pada pin 6 dari op-amp, dan mengubah nama net lebih suka analog_out di Settings Net kotak dialog. 
2. Pilih Simulasikan »Analisis» Analisis AC dan klik pada tab Output. 

[image: ]

3. Sorot V (analog_out) di kolom kiri dan klik Add. V (analog_out) bergerak ke kolom kanan. Hal ini menunjukkan tegangan pada node V (analog_out) akan ditampilkan setelah simulasi. 
4. Klik Simulasikan. Hasil analisis muncul dalam Grapher tersebut
[image: ]

The Grapher 

The Grapher adalah alat display multi-tujuan yang memungkinkan Anda melihat, mengatur, menyimpan dan ekspor grafik dan diagram. Hal ini digunakan untuk menampilkan hasil dari semua Multisim analisis di grafik dan diagram dan grafik trace untuk beberapa instrumen (misalnya hasil osiloskop).
 
Lakukan langkah-langkah berikut untuk melihat hasil simulasi pada Grapher: 
1. Jalankan simulasi dengan osiloskop seperti yang dijelaskan sebelumnya. 
2. Pilih View »Grapher

[image: ]
The Postprocessor 

Gunakan postprocessor untuk memanipulasi output dari analisis dan plot Hasil pada grafik atau diagram. Jenis operasi matematika yang bisa dilakukan pada hasil analisis meliputi aritmatika, trigonometri, eksponensial, logaritma, kompleks, vektor dan logika. 

Report

Anda dapat menghasilkan sejumlah laporan di Multisim: Bill of Material (BOM), Komponen Detil Report, netlist Report, Skema Statistik, Spare Gates dan Laporan Referensi Silang. Bagian ini menggunakan BOM sebagai contoh untuk rangkaian tutorial

Bill of Material 

Sebuah bill of material berisi daftar komponen yang digunakan dalam desain Anda dan oleh karena itu menyediakan ringkasan dari komponen yang diperlukan untuk memproduksi rangkaian  naik. Informasi yang diberikan meliputi: 

· kuantitas setiap komponen yang diperlukan. 
· deskripsi dari setiap komponen, termasuk jenis komponen (contoh: resistor) dan nilai (contoh: 5.1 kohm). 
· designator referensi masing-masing komponen. 
· paket atau trace dari masing-masing komponen. 

Menyelesaikan langkah berikut untuk membuat BOM (bill of material) untuk Anda  rangkaian: 

1. Pilih Laporan »Bill of Material. 

Laporan itu muncul, tampak mirip dengan ini

[image: ]

[image: ]Untuk mencetak Bill of Material, klik tombol Print. Sebuah standar Windows kotak dialog print muncul, yang memungkinkan Anda untuk memilih printer, jumlah eksemplar, dan sebagainya. 
[image: ]Untuk menyimpan Bill of Material untuk file, klik tombol Save. Sebuah standar  Jendela file save kotak dialog muncul, di mana Anda menentukan path dan file yang  nama.

Karena Bill of Material terutama ditujukan untuk membantu dalam pengadaan  dan manufaktur, hanya mencakup "nyata" komponen-itu tidak termasuk  komponen yang tidak nyata atau tersedia untuk pembelian, seperti sumber atau  komponen virtual. Komponen tanpa trace kaki ditugaskan tidak muncul  dalam Bill of Material .

[image: ]Untuk melihat daftar komponen di rangkaian yang tidak "nyata" komponen,  klik Virtual tombol. Sebuah jendela terpisah muncul, menunjukkan ini komponen saja. 

 Informasi lengkap mengenai ini dan laporan lainnya dapat ditemukan di Multisim Help


[image: ]Ultiboard Tutorial


Tutorial dalam bab ini menempatkan bagian dan trace untuk sirkuit dijelaskan dalam Bab 2, Multisim Tutorial . Beberapa fitur yang dijelaskan mungkin tidak tersedia dalam edisi Anda Ultiboard. Mengacu pada NI Circuit Design Suite Catatan Rilis untuk daftarfitur yang tersedia dalam edisi Anda. 

Pengantar Ultiboard Antarmuka 

Ultiboard adalah aplikasi layout PCB dari Instruments Circuit Nasional Desain Suite, sebuah suite EDA (Electronics Design Automation) alat yang membantu Anda dalam melaksanakan langkah-langkah utama dalam aliran desain sirkuit. Ultiboard digunakan untuk lay out dan dicetak dengan board sirkuit, melakukan tertentu CAD mekanik operasi dasar, dan mempersiapkan board untuk manufaktur. Ini juga menyediakan penempatan bagian otomatis dan kawat routin























antarmuka Ultiboard ini terdiri dari beberapa elemen

[image: ]

Menu Bar adalah di mana Anda menemukan perintah untuk semua fungsi.

Standard Toolbar berisi tombol untuk fungsi umum-dilakukan seperti bintang, Print, Cut, dan Paste. 

Ketika Anda menambahkan lebih banyak bagian dan trace ke board, dapat menjadi sulit untuk memilih hanya mereka yang ingin Anda gunakan. The Pilih toolbar berisi tombol yang digunakan untuk mengontrol pilihan

Draw Settings Toolbar adalah di mana Anda memilih lapisan, ketebalan dan Unit dari ukuran garis atau obyek yang sedang ditarik. Hal ini juga berisi tombol untuk fungsi yang mengontrol munculnya garis-garis dan bentuk yang ditarik pada lapisan.
 
View Toolbar berisi tombol untuk memodifikasi cara layar ditampilkan. 

Main Toolbar berisi tombol untuk fungsi desain board umum.

Autoroute Toolbar berisi autorouting dan penempatan bagian fungsi.

Status Bar menampilkan informasi yang berguna dan penting.

Workspace adalah di mana Anda membangun desain Anda.

Spreadsheet View memungkinkan tampilan canggih cepat dan pengeditan parameter termasuk rincian bagian seperti bentuk, designators Referensi,  atribut dan kendala desain. 

Desain Toolbox memungkinkan Anda menampilkan, menyembunyikan, atau redup elemen desain Anda.

3D Preview berisi preview tiga dimensi dari board.

Birds Eye View menunjukkan desain sekilas dan memungkinkan Anda dengan mudah
bernavigasi di seluruh ruang kerja

Tutorial 

Lakukan langkah-langkah berikut untuk membuka file tutorial: 
1. Pilih Start> All Programs » National Instruments » Circuit Design Suite 11.0 » Ultiboard 11,0 untuk memulai Ultiboard.
2. Pilih File » Open Samples dan double-klik untuk mulai  membukanya. 
3. Pilih Getting Started.ewprj dan klik Open . File proyek yang akan dimuat ke Ultiboard. 
[image: ]  Tip Untuk petunjuk tentang mengekspor desain dari Multisim ke Ultiboard, merujuk pada 
Bantuan Multisim dan Bantuan Ultiboard
[image: ]

4. Untuk memilih desain dari proyek (misalnya, GS1), Baik klik tab, atau klik pada nama di Proyek tab dari Desain Toolbox .

Membuat Board Outline 

Sudah ada Board Outline, namun, Anda dapat membuat satu yang lebih ukuran cocok untuk bagian dalam desain ini dalam salah satu cara berikut: 

· Menggambar Board Outline menggunakan alat gambar. 
· Mengimpor file DXF. 
· Gunakan Board Wizard.

Lakukan langkah-langkah berikut untuk bereksperimen dengan Board Wizard:

1. Klik dua kali pada Board Outline di Layers tab untuk membuat layar aktif.
2. Klik pada the existing board outline yang ada di GS1 desain dan tekan <Delete> pada keyboard. 
3. Pilih Tools » Board Wizard
[image: ]

4. Aktifkan Change the layer technology pilihan untuk membuat Technology pilihan yang tersedia.
5. Pilih Multi-layers constructed with double-sided boards and single layer stack-ups, dan klik Next

Kotak dialog berikutnya adalah di mana Anda menentukan Lamination settings untuk board. (Untuk tutorial ini Anda tidak akan mengubah pengaturan.) 

[image: ]

6. Klik Next .

Dalam Board Wizard - Shape of Board kotak dialog:

· pastikan Reference Point diatur ke Bottom-left for Alignment.	
· pastikan Rectangular opsi yang dipilih untuk Board shape and size.
· mengatur untuk Width/Lebar = 3000 dan Height/Tinggi = 2000 (ukuran lebih cocok untuk bagian-bagian dalam desain ini). 
· mengatur Clearance/Jarak ke 5,00000. Ini adalah jarak dari tepi board yang akan bebas dari bagian atau unsur-unsur lain. 

7. Klik Finish. Board Outline ditempatkan pada desain Anda.

[image: ] Catatan 
Untuk rincian lengkap tentang Board Wizard,  lihat Bantuan Ultiboard

Lakukan langkah-langkah berikut untuk memindahkan Board Outline: 

1. Klik dua kali pada Board Outline di Layers tab.
2. Klik di mana saja di Board Outline di ruang kerja dan tarik board ke lokasi tepat di bawah deretan bagian. 




Lakukan langkah-langkah berikut untuk mengubah titik acuan: 

1. Pilih Design » Set Reference Point. Titik referensi yang ada pada kursor Anda. 
2. Pindahkan kursor sudut kiri bawah dari Board Outline dan klik ke tempat itu

[image: ]

Menempatkan Parts 

Anda dapat menempatkan bagian pada GS1 file desain dalam beberapa cara yang berbeda: 
· pilih satu atau lebih bagian dari luar Board Outline dan menyeret mereka ke tempatnya. 
· menggunakan Parts pada tab di Spreadsheet View untuk menemukan bagian-bagian dan tempat mereka. 
· pilih dan menempatkan bagian dari database. 

[image: ] Tip Gunakan tempat »Unplace Parts perintah untuk cepat menghapus semua bagian non-terkunci dari PCB dan percobaan dengan teknik penempatan yang berbeda


Draging Parts dari luar Board Outline

Secara default, parts ditempatkan di luar Board Outline ketika Anda membuka netlist dari Multisim atau program lain capture skema. 

Sebelum Anda mulai, klik dua kali Copper Top layer dalam Desain Toolbox untuk membuat layer aktif. 

Lakukan langkah-langkah berikut untuk memindahkan U1 dari luar Board Outline:
 
1. Cari U1 dalam koleksi bagian luar Board Outline. Untuk membuat ini lebih mudah, menggunakan roda mouse untuk memperbesar sampai Anda dapat melihat U1. 
[image: ] Tip Anda juga dapat mencari bagian dengan perintah Edit » Find. Sementara perintah ini bekerja seperti fungsi Find dalam aplikasi lain, juga memungkinkan Anda untuk mencari bagian berdasarkan nama, jumlah, bentuk, nilai, atau oleh semua variabel. Mengacu pada Ultiboard Help untuk lebih rinci.

2. Klik pada U1 (layar 7-segmen) dan tarik ke lokasi yang ditunjukkan pada gambar di bawah

[image: ]

U1 tetap terpilih. Ini adalah poin penting bagi Ultiboard yang memegang peran dalam seluruh aplikasi-Anda sehingga perlu secara eksplisit mengakhiri setiap tindakan tertentu. Dalam hal ini, hanya dengan mengklik di tempat lain untuk memilih bagian. Klik kanan untuk mengakhiri tindakannya. 

3. Pergi ke Parts tab di Spreadsheet View dan Scroll ke U1. Kamu akan melihat bahwa lampu hijau di samping bagian yang sedikit lebih terang-ini menunjukkan bahwa bagian tersebut telah ditempatkan


Dragging Parts dari Parts Tab 

Lakukan langkah-langkah berikut untuk Dragging Parts dari Parts tab:

1. Pada Bagian tab, gulir ke bawah sampai Anda melihat J3.

[image: ]

2. Klik pada J3 dan tarik dari Bagian tab ke ruang kerja. J3 adalah melekat pada pointer mouse Anda. 
3. Jatuhkan J3 di tepi kiri board, kira-kira di tengah. Seperti sebelumnya, di Bagian tab lampu hijau J3 adalah sedikit lebih cerah, yang menunjukkan bahwa bagian telah ditempatkan. 

Tutorial Menempatkan Parts 

Menggunakan metode atau kombinasi metode, membuat tata letak Anda terlihat seperti ilustrasi di bawah. Anda juga dapat hanya membuka file desain berikutnya dalam proyek, GS2 , Yang telah diatur dengan cara ini. 

Desain Anda akan terlihat seperti ini

[image: ]

Menempatkan Parts dari Database 

Selain menempatkan komponen impor sebagai bagian dari file desain Anda, Anda dapat menempatkan bagian langsung dari database. berikut ini menggunakan metode ini untuk menempatkan lubang mounting. 

Lakukan langkah-langkah berikut untuk menempatkan bagian dari database:

[image: ] 
1. Pilih Place » From database. Get a Part From the Database maka kotak dialog akan terbuka. 
2. Dalam panel Database, untuk mengekspan pilih kategori Through Hole Technology Parts dan arahkan ke kategori  Holes. Bagian muncul di  panel Available parts.
3. Pada panel Available parts, pilih Hole35. Bagian  tersebut akan ditampilkan pada panel Preview.

[image: ]

4. Klik OK. Get a Part From the Database maka dialog box akan menghilang, dan Anda diminta untuk memasukkan RefDes dan Value.
5. Masukkan hole’s reference designator (H1) dan nilai (HOLE) kemudian klik OK .
6. Pindahkan pointer di atas board. Bagian yang melekat pada pointer
7. Ketika lubang berada di posisi di sudut kiri atas, klik untuk menaruhnya pada board. 
8. Enter Reference Designation for Part maka kotak dialog muncul kembali, dengan penanda referensi otomatis akan bertambah ke H2. 
9. Masukkan nilai (HOLE) dan klik OK untuk menempatkan Hole untuk pemasangan berikutnya di sudut kanan atas, dan ulangi untuk menempatkan H3 di kanan bawah sudut, dan H4 di sudut kiri bawah. 
10. Klik Cancel untuk menghentikan, dan klik Cancel lagi untuk menutup Get a Part From the Database  kotak dialog.

[image: ]

Bagian yang bergerak 

Anda dapat menggunakan metode yang sama untuk bagian yang bergerak seperti yang Anda lakukan untuk menempatkan mereka. Untuk memilih bagian yang sudah di board, cukup klik di atasnya. Untuk menentukan X / Y koordinat dimana bagian yang dipilih adalah untuk memindahkan, tekan < *> tombol pada tombol angka. Atau, di Bagian tab, pilih bagian ditempatkan (Ditunjukkan dengan lampu hijau terang sampingnya) dan tarik ke lokasi baru. 

[image: ] Tip label bagian dan bantalan adalah elemen yang terpisah dari bentuknya. Ketika memilih bagian di board, pastikan untuk memilih seluruh bagian, bukan hanya label atau bantalan. Gunakan Selection Filter untuk membantu dengan ini. Mengacu pada Bantuan Ultiboard untuk informasi lebih lanjut.
[image: ] Tip Setelah bagian yang dipilih, Anda juga bisa bergerak di sekitar di board dengan menekan tombol panah pada keyboard Anda


Anda juga dapat memilih kelompok bagian dan memindahkan mereka bersama-sama. Untuk melakukan ini, Anda dapat melakukan salah satu dari berikut: 

· tahan <Shift> dan klik pada lebih dari satu bagian. 
· menyeret kotak sekitar beberapa bagian.

 Semua bagian yang dipilih akan bergerak bersama-sama ketika Anda tarik kursor. 
[image: ] Tip Ini adalah kelompok-sekali sementara Anda memilih bagian lain, koneksi kelompok adalah kalah. Untuk membuat grup yang tetap sampai Anda menghapusnya, Anda dapat menggunakan Group Editor. Untuk rincian, lihat Ultiboard Help .

Pilihan lain untuk bagian yang bergerak adalah dengan menggunakan perintah Edit » Align untuk menyelaraskan tepi bagian yang dipilih atau ruang mereka relatif terhadap satu sama lain. 

Gunakan Edit » Align perintah untuk menyelaraskan lubang pemasangan Anda hanya ditempatkan:

1. Pilih H1 dan tahan <Shift> untuk memilih H2. 
2. Pilih Edit » Align » Align Top. Jika H2 awalnya tidak ditempatkan persis sejalan dengan H1, Anda akan melihatnya bergerak. 
3. Klik pada ruang kosong di board tulis, kemudian pilih H2 dan H3. 
4. Pilih Edit » Align » Align Right.
5. Lanjutkan dengan cara ini untuk menyelaraskan bagian bawah H3 dan H4, dan meninggalkan sisi H1 dan H4

Placing Traces 

Anda memiliki opsi berikut untuk menempatkan trace: 
· manual trace.
· follow-me trace.
· connection machine trace. 

Trace pengguna ditempatkan persis seperti yang Anda tentukan, bahkan berjalan melalui komponen atau melacak jika itu adalah jalan Anda berangkat. Trace follow-me otomatis menarik trace valid antara pin Anda pilih dengan Anda gerakan-mouse Anda dapat berpindah dari pin ke pin, meninggalkan trace yang valid. SEBUAH koneksi mesin trace otomatis bergabung dua pin dengan paling efisien rute, meskipun Anda memiliki pilihan untuk mengubah itu. 
Ketika Anda menempatkan trace, dan sebelum Anda mengklik untuk memperbaikinya di tempat, Anda dapat selalu menghapus segmen dengan back up di atasnya. Setiap kali Anda mengklik sementara menempatkan trace manual, atau setiap kali tindak saya melacak atau koneksi mesin trace mengubah arah, segmen yang terpisah dari trace yang dibuat. Kapan melakukan operasi pada trace, pastikan untuk memilih yang sesuai segmen atau, jika Anda ingin, seluruh trace. 

Placing a Manual Trace 

Anda dapat melanjutkan dengan desain Anda telah bekerja pada, atau membuka GS3. Pastikan Anda berada di Copper Top lapisan sebelum awal- Copper Top harus disorot dalam warna merah di Layers tab dari Desain Toolbox .

[image: ] Tip Jika perlu, tekan <F7> untuk menampilkan seluruh desain. 

Lakukan langkah-langkah berikut untuk menempatkan trace secara manual: 

1. Pilih Place » Line.
[image: ] Tip perintah Line command ini digunakan untuk membuat garis pada setiap lapisan. Hasil berbeda tergantungpada layer yang dipilih. Misalnya, jika lapisan yang dipilih silkscreen, Anda akan membuat garis pada lapisan silkscreen PCB. Jika lapisan yang dipilih adalah lapisan tembaga, maka "garis" adalah sebenarnya trace. 

2. Cari J3, menuju bagian kiri board. Cari awal pin ditunjukkan di bawah ini

[image: ]

[image: ] Tip Anda dapat mematikan atau meredupkan Force Vectors untuk melihat jaring lebih jelas. Apakah menggunakan iniyang Force Vectors kotak centang di Layers tab dari Desain Toolbox . Mengacu kepada Bantuan Ultiboard untuk informasi lebih lanjut tentang Force Vectors

[image: ]  Tip Jika Anda memiliki kesulitan untuk bagian, gunakan Find fungsi dari Parts tab. pilih bagian dalam Parts tab, lalu klik tombol Find and select the part. Bagian yang ditunjukkan pada ruang kerja. Jika perlu, tampilannya lebih jauh menggunakan roda mouse. 

3. Klik pada pin yang ditentukan pada langkah di atas. Ultiboard menyoroti semua pin yang merupakan bagian dari jaring yang sama seperti pin Anda klik dengan X. (Warna penyorotan dapat diubah di Colors tab dariPreferensi global kotak dialog.) Ini adalah bagaimana Anda tahu mana pin untuk terhubung untuk mencocokkan konektivitas dari skema Anda

[image: ]

4. Pindahkan kursor ke segala arah. Garis hijau (trace) melekat pin yang dipilih. Setiap kali Anda klik, Anda jangkar segmen trace, sebagai ditunjukkan pada gambar di bawah ini (2). 
5. Klik pada pin tujuan. 

[image: ]

6. Klik kanan dan pilih Cancel untuk menghentikan menempatkan trace
[image: ]
7. Klik Pilih tombol pada Main toolbar untuk keluar dari mode line-menempatkan.

Placing a Follow-me Trace 

Lakukan langkah-langkah berikut untuk menempatkan tindak saya melacak: 
[image: ]
1. Pilih Tempat »Ikuti saya .
2. Klik pada pin atas J3. 
3. Klik pada pin kedua dari bawah di sisi kiri U4. 
4. Ultiboard menarik sambungan untuk Anda. 

[image: ] Tip Anda tidak perlu klik tepat pada pin-Anda juga dapat memulai dengan mengklik ratsnest sebuah garis. 

Placing a Connection Machine Trace 

Lakukan langkah-langkah berikut untuk menempatkan Connection Machine trace:
1. Pilih Place » Connection Machine.
2. Klik pada segmen ratsnest ditunjukkan di bawah
[image: ]

3. Pindahkan Anda kursor-Ultiboard menunjukkan berbagai trace penempatan Pilihan dialihkan sekitar hambatan
4. Bila Anda melihat rute yang Anda inginkan, klik untuk memperbaiki trace. Anda tidak memiliki untuk mengklik ratsnest atau pin tujuan
[image: ]

5. Klik kanan untuk mengakhiri penempatan trace. 

Auto Part Placement 

Serta menempatkan bagian seperti yang dijelaskan sebelumnya dalam bab ini, Anda dapat menggunakan maju otomatis fungsi penempatan bagian Ultiboard ini. 
[image: ] Tip Sebelum autoplacing bagian, pre-tempat dan mengunci bagian apapun yang Anda tidak ingin menjadi pindah selama proses autoplacement. (The lubang pemasangan, dan U1, J1, J2, J3, dan LED 1 di GS5 memiliki telah pra-ditempatkan dan terkunci.) Untuk rincian tentang penguncian bagian, mengacu pada Ultiboard Help

Lakukan langkah-langkah berikut untuk autoplace bagian-bagian dalam Getting Started.ewprj : 

1. Buka GS5 desain di Ultiboard. 
2. Pilih Autoroute » Start Autoplacement. Bagian-bagian yang ditempatkan pada board sirkuit. 

Autorouting Traces 

Anda dapat menempatkan trace di Ultiboard menggunakan metode yang dijelaskan sebelumnya dalam bab ini, atau secara otomatis rute trace seperti yang dijelaskan di bawah ini. 

Lakukan langkah-langkah berikut untuk Autoroute trace di Mendapatkan Started.ewprj :

1. Buka GS3 desain di Ultiboard. 
2. Pilih Autoroute » Start/Resume Autorouter. ruang kerja beralih ke Autorouter mode dan trace autorouting dimulai.

Sebagai hasil autorouting, Anda akan melihat trace-trace yang ditempatkan di board. Ketika autorouting selesai, Autorouter Mode menutup dan Anda kembali ke ruang kerja. 

3. Opsional, pilih Autoroute»Start Optimization untuk mengoptimalkan penempatan trace.

[image: ]

autorouter dapat dihentikan setiap saat dan Anda dapat membuat pengguna perubahan seperti yang diinginkan. Ketika Anda me-restart autorouter, akan dilanjutkan dengan 

perubahan yang Anda buat. Jangan lupa untuk mengunci setiap jejak yang Anda telah menempatkan manual dan tidak ingin dipindahkan oleh autorouter. 

[image: ] Tip Gunakan Routing Options kotak dialog untuk memodifikasi autoplacement dan autoroutingPilihan. Mengacu pada Bantuan Ultiboard untuk rincian.


Preparing for Manufacturing/Assembly 

Ultiboard dapat menghasilkan banyak format output yang berbeda untuk mendukung Anda produksi dan manufaktur kebutuhan. Bagian ini menjelaskan fungsi dilakukan untuk keluaran board Anda untuk produksi dan dokumentasi tujuan. 

Cleaning up the Board 

Sebelum mengirim board untuk manufaktur, Anda harus membersihkan setiap terbuka jejak ujung (segmen jejak yang tidak memiliki koneksi terminating di desain) dan vias yang tidak terpakai yang telah ditinggalkan di board. 

Untuk menghapus terbuka jejak berakhir, buka GS4 merancang dan memilih Sunting »Tembaga Hapus »Terbuka Jejak Berakhir . Ini akan menghapus semua jejak terbuka berakhir dalam desain.

Untuk menghapus vias yang tidak terpakai, pastikan desain terbuka dan memilih Merancang »Hapus Vias tak digunakan untuk menghapus semua vias yang tidak memiliki jejak apapun segmen atau daerah tembaga terhubung ke mereka. 

Adding Comments 

Komentar dapat digunakan untuk menunjukkan perintah perubahan rekayasa, untuk memfasilitasi kerja kolaboratif antara anggota tim, atau untuk memungkinkan latar belakang Informasi harus terpasang ke desain. 

Anda dapat "pin" komentar ke ruang kerja, atau langsung ke bagian. Ketika sebuah bagian dengan komentar terpasang dipindahkan, komentar juga bergerak.

Untuk detail, lihat Ultiboard Help.

Exporting a File 

Sebuah file yang diekspor berisi informasi lengkap yang menjelaskan bagaimana selesai board yang akan diproduksi. File yang dapat diekspor meliputi Gerber RS-274X dan RS-274D file. 

Untuk rincian lengkap, lihat Bantuan Ultiboard.

Viewing Designs in 3D 

Ultiboard memungkinkan Anda melihat apa board terlihat seperti dalam tiga dimensi pada setiap 
waktu selama desain. Untuk rincian lengkap, lihat Bantuan Ultiboard .

[image: ]

[image: ] Tip Anda dapat menggunakan Internal View untuk melihat antara lapisan multi-layer PCB. Untuk rincian, lihat Ultiboard Help.

image3.png
E)

2
DL PR v . el
IV A

£ =
sty [ . ] ey i
& X
= WG PSR

& ElE "V E e EE
Seprp—
®
T e A L
] i § Dt § ot o Seatieetion
RO T vl

4 Standard Toobar





image4.png




image5.png
i Getting Started Final - Multisim - [Getting Started Final] [B=X]

[ Be Edt View Ploce Smiste Transfer Toos Reports Opfions Window Hel I8l
&R heYeBeaaqle W B @ b nweun [v]2 B
|+ >* s« BB IpEo=mY @R 5| %W ][> ufae |

o I L I B I : I . I : | I 0 I 0 I 0 I
Ce vee vee oy
L w f i “ =
7Dj 18 g L =
5 A, ’ o
- = 1l l =
| o | oo | | o, Lljf -
R’ 144 =
o =
= -
o

: ) AT =]
Counter Control R -

- vee Rt
£l 00 @
—" o E
o T =
H e
2 = ;
. . — L = )
Roret e [}
| | Lo VO st o N
Geting ssted ol A &

[





image6.png
& Select a Component

Symbol (ANST) .

[ Eoer——

B voumerer
A} AMMETER.
[
Lheuzzer
& Lavp

RTUAL LA
[
Bl errcrart

< m

ose
Search,
Detai report

view model

e
(X

e

Function

7 SEGMENT DISPLAY, WITH DECIMAL POINT CONMON ANODE
VF=3.45V @ 20mA

Model manfacturer/ID
Generic | SEVEN_SEG_D_COM_A

Footprint manufacturer/type:
Generc | 75EGEDIP10A
(Generc | 7SEGEDIP148
Generic | DISP1105

Fyperink:
>

(Compornents: 1

Searching: seven_seq_decinal_com_a_blus





image7.png
vee vee

5V 5V
U1
R
nLEDI
[T
R1
%mn Rt
2 5% 3 RPACKT (180 (1
T
] @ e o
ECHE o= Hi g
ekl @ - =t m [l
2pe
o m Hdu FH
o b By *
R
$GND TALS4TN

T4HC190N





image8.png




image9.png
Key = Space.
Lo T





image10.png
v

02 vk
{~ )tk
N aeg

R
ke
5%





image11.png
Lo

Lo le

TouF
T





image12.png




image13.png
u2

:

e

‘Lo

)
sty

T4HC190N

R1
2000
5%





image14.png
vee vee

5V 5V
Ut
)
!h LED1
. il
2000 U gy
U2 U3 RPACK? (180
TTTTTTT
N I
R H: o3 |\‘
= Hi %
2
i am A
D o A 2o .B1/mB0
sl mm P
.
D TALSATN

T4HC190N





image15.png
vee

W

vee
e w
PR Jo
oo
~ T
W
)
v o
o " vee wee
0wk Lo swa s
“maz Zs Key=Space T T
ey
¥ "
s
Conter comar &y
e w
Sma .
w v wrecer [i00
Koy~ shacs S o ij
L SSI I |
» o m = £
Ko spacs o T TS
Loy Tancioon





image16.png
-

Oscilloscope-XSCT

e GhvelA  Chaoa D

(§77)(ead) eia (o) | (ac)Lo J(OE)

()L

0,005 .00V 882486 V. Reverse
0B oy maEm
i I e
T Gl [, T
i 2o s S0 sclr 5 90|27 % BEED
epon0 [0 |vpmr [0 vronwy [0 vt [o b
[Sinole ) (ormal ) [Auko) (one |





image17.png
AC Analysis

Frequency parameters | Output | Analysis options | Summary |

Variables n circut: Selected variables for analysis:

Al variables Al variables

2)
(20}
viz1)
V(z2z)
o ——
P [ ST
w7)
¥(8)
vz <[ memoe <
W(analog_out)
Wgnd)

WVivee)

Edit expressin.

<

[ Fhorsmsbced varaese: | [ Adiopressone: ] [ Fhorsoced varas

More options

‘Add device/mogel parameter.
Delte selected variable

Show alldevice parameters at end
oF simation n the aud tral

Comee J o J[ o J[ o





image18.png
apher View
Graph Trace Cursor Legend

I [ E]tit |

Getting Started Final
AC Analysis
- -

5\4
%

a
& a

Magnitude

10 48 280820 2800 1.0k 4Bk 280k 1.0M 10.0M  100.0M 10G 100G
Frequency (Hz)

Vianalog_ou)

a
o a " o o
10 46 2808202800 10k 46k 280K 10M 100M 1000M  10G 100G

Frequency (Hz)

Vianalog_ou)





image19.png
apher View
Graph Trace Cursor Legend

(SIS

ge(V)

(AJebyoA g 1euUURYD

£
S
=
<
T
2
3
G
£
[

g Chamel &y Chamnel 8





image20.png
Bill of Materials (From Document: Getting Started 2)
CEEY IR
Quantty | Desarption Refoes [ _redon ]

it ‘CAP_ELECTROLTT, 10F a PCTatChp-CI2i0 A
[t ‘CAP_ELECTROLIT, 10nF @ IPC-73514Chip-C1210
[t ‘CAP_ELECTROLIT, 100uF (=) IPC-73514Chip-C1210
[« SWITCH, SPDT 2 GenericlsPDT

[s]t CONNECTORS, HDR14 B Generic|HOR 14

[e]t LED_blue LEDt Ukiboard\LEDSR2_Sitb
7]t RESISTOR, 2000 5% R IPC-73511Chip-R080S
[&]t POTENTIOMETER, 50k Rz GenericiLIN_POT

[t RESISTOR, 1k2 5% R3 IPC-73511Chip-R080S

ma RPACK_VARIABLE 247, 1800hm R4, 1PC-22214[2222\DIP-14
it ‘SEVEN_SEG_DECIMAL_COM_A BLUE U1 Generic|7SEGEDIP10A
2]t 74L5, 74L51908 3 1PC-22214{2222MO016
5] 74LS, T4LS4TN us 1PC-22214{2222MO016
[le >





image21.png




image22.png




image23.png




image24.png




image25.png
IHUUEN S TS NI I e b (R eV h Wi,

AP P TI=k]
- 2

®
S Gerrfustred - Uinibpard - (G541 O
0 oeWea e b [t Tasi . a e

] EE N1 Y
S e 3
i com wi | o

rets [Fatgags] o |t rogs] 4] s v ] gt owp b cpa s st 1

o eme(c1) o) shooe e cizzver) )

1 Menu Bar 5 View Toolbar 8 Status Bar 11 Design Toolbox
2 Standard Toolbar 6 Main Toolbar 9 Workspace 12 3D Preview

3 Select Toolbar 7 Autoroute Toolbar 10 Spreadsheet View 13 Birds Eye View
4

Draw Settings Toolbar





image26.png
GettingStarted - Ultiboard - [GS1] B =

£ Ele Edt Wew ace Desn Transfer ook Autoroute Options Window belp 18]
DE W B = Ra8Q & HEY D S EF L% M
[V [ Y % [¥1 | [V [ Zs | [copper op | Automati (00000 m) (v ][mi v, 2

EE|

R P A R R N R A
DS edgB||r-

= (9] Gettingstarted
£t
02
06
e
06

rojects [Layers 0 61 [0 2 8 5[ @ ese[ @ o bl

E
o

] 2l &l Bl £ M 5 |m
Refbes | Vaue | Shope | Locked | Traceclarance | Partspacg Pinswap (&
@ o  Ow Doece B ¥ 10000 1 0.0000  es
e o 10F  CARCRZ.. fio 10.0000 0.0000 Ves
e o 1000 CARCEZ... tio 10,0000 0.0000 ves v
< >

Reshe ] DRC _ parts [Partrouss | Nets ] Notgroups | ST Pads ] T Pade] ] opper seae] Keopirsiesprouts | Copperlayers ] parts postion | 4>





image27.png
Board Wizard - Board Technology

[Jchange the layer technology

(Changing layer technology may cause DRC errors when vias or parts are aready placed on the design and copper placed
onlayers that are removed will be delted)

Technalogy

Double-sided
Mukiayers constructed with double-sced boards (iayer pais)

Mulkayers constructed with double-sided boards and singl layer stack-ps

<Back.





image28.png
joard Wizard - Copper Layers

Laination settings
Layer gais:
Single layer stack-ups:

T

Battom:

Inrerlayers: 0

Bing vias:
Buried vias

Micro vis:

Through Board Vi from Copper Top to Copper Bottom

i) (>

=

][

e





image29.png
LA
).





image30.png
range line) Ratsnest (yel





image31.png
] 2l &l Bl £ M 5 |m
Refbes | Vaue | Shope | Locked | Traceclarance | Partspacg Pinswap (&
e ST SWSP Mo 10.0000 Use DesignRule ... Yes
@ 1 ORI MRS ENo Y 0000 0 Use Design Rule .7 Yes
@ Lot LED .. LEDSRZ ... Mo 10,0000 Use DesianRule ... Yes ¥
< >

Rosits | DRC_ ports [Partgrotps ] Nets | Nt groups ] ST Pads ] THT Pads ] as ], Copper areas ] Keep s eep-aus | Copperlayers ] Parts postion ] <>





image32.png




image33.png




image34.png
Database:

S Thraugh Hale Technalog{ A

1
Diades

Bridge Rectiers
Voltage Regultors
DCDC Converters

% LED Displays
# Connectars

Batteries & Sockets
Holes
Buzzers

) Capacitors
# Buttons & Switches

Crystalsfoscllators
Relays
Pawer Rectfiers

 Get a Part From the Database

Eiter: [alltypes | (Shon dimensions ]
bvalable parts: Preview @ aQq
HOLESS

Boois o

@eos 1
@603 2
@603
[
P60z s
Il #2057
Peos s
Il 2050

B4 0
 ecs 0
fBHoLE
1 faroies]

< >

Shaw subtree contents o J[ concel J[tep ]





image35.png




image36.png
2 SanPin

Part J3

1





image37.png
Pins in the Same Net





image38.png
1

Trace

3 Destination Pin

2 Click to anchor trace





image39.png




image1.png




image40.png




image41.png




image42.png




image43.png
Calbol





image44.png




image2.png




